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DONATE TO ONF to receive 
this Will Rogers print. Details at 
OkPress.com/will-rogers.

Register now to attend the Oklahoma 
Press Association’s annual Legislative 
Summit on Thursday, Feb. 8, for an oppor-
tunity to meet with your legislators at the 
Oklahoma State Capitol in Oklahoma City.

The summit begins with a group meet-
ing in the Blue Room on the second floor 
at 9:30 a.m. where OPA Executive Vice 
President Mark Thomas will provide a 
quick briefing before everyone breaks to 
visit legislators in their offices.

Following lunch, Oklahoma Governor 
Mary Fallin will speak to OPA members.

The summit offers publishers, editors 
and other newspaper staff members a 
chance to ask their local legislators to sup-
port decisions affecting the newspaper 
industry.

Legislators rank a personal visit with 
their constituents as the most effective 
contact. They listen to people who make 
time to come to the capitol and express 
their concerns. 

Newspapers have several important 
legislative principles to support and 
defend, including First Amendment 
issues, Freedom of Information issues, 
and business issues affecting newspapers, 
such as public notice, and taxation of 
advertising and circulation. 

Plan on attending the Feb. 8 Legisla-
tive Summit and make sure your voice is 
heard. Registration is free and includes 
lunch. To register, go to www.OkPress.
com/legislative-summit. 

The deadline for the 2017 Oklahoma 
Press Association Better Newspaper Con-
test is approaching and we want to award 
the talent at your newspaper.

Did you have a great news story, sports 
story, column, feature or editorial during 
2017? Enter it in the contest. How about an 
amazing print ad? Enter it in the contest. 
An amazing front-page design? Yeah, you 
can enter that, too. We didn’t forget pho-
tographers, either. This year, you can enter 
individual news, feature or sports photos in 
the contest. 

And, many of the categories for staff 
members and newspapers allow up to four 
entries per newspaper. 

You’re not too big or too small to enter 
the annual newspaper contest. OPA busi-
ness members will compete in nine circula-
tion divisions to level the playing field. 

To paraphrase two Oklahoma journal-
ism professors, good writing is good writ-
ing whether it’s in the New York Times or 
a small-town Oklahoma newspaper. The 
same is true for ad design, page layout, 
photography and other categories in this 
year’s contest. The smallest newspaper in 
the state could have the best entry and be 
recognized for its work.     

The deadline for entries is Monday, Feb. 
12, 2018. Most entries will be judged as full-
page digital tearsheets in PDF format. 

Now it’s easier than ever to choose 
entries and upload PDFs. Simply click a 
couple of links and type in a few words. 

Several of you already have experience 
with these online contest platforms having 
judged other states’ contests.

It’s a new process but we’ve created step-
by-step instructions to guide you through 
the operation. If you still have questions or 
are having problems, just give us a call. 

Make this the year that you enter the 
OPA Better Newspaper Contest. Whether 
it’s entering one category or all 20, it’s your 
opportunity to receive recognition for your 
hard work.

OPA members to meet at capitol for Legislative Summit

WHAT YOU NEED TO KNOW ABOUT ENTERING THE 
2017 OPA BETTER NEWSPAPER CONTEST

ENTRY DEADLINE:
MONDAY, FEB. 8, 2018

CONTEST RULES: 
www.okpress.com/contest

UPLOAD ENTRIES AT: 
www.betternewspapercon-

test.com/OPA

QUESTIONS?
Contact Lisa Sutliff, LSutliff@okpress.com 

or Jennifer Gilliland, jgilliland@okpress.com
or phone (405) 499-0020 

1-888-815-2672 (toll-free in state)

Contest honors newspapers, staff
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I spent a good portion of last week-
end going through our archives to pick 
out entries for the OPA Better Newspa-
per Content.

And, for the first time, I was not ruf-
fling through stacks of old papers to get 
the entries. That’s because most of this 
year’s contest categories have digital 
entries. Three still require us to mail 
entire copies of the paper, but it’s excit-
ing that the bulk of them will be of the 
click-and-upload variety. Makes me a 
happier camper.

It is exciting, too, because, for the 
first time, this year’s contest will recog-
nize individuals for their work, as well 
as the newspapers.

There will be 20 contest categories, 
with results from eight of them count-
ing toward the Sequoyah Award. Those 
are: News Content; Layout & Design; 
Advertising; Editorial Writing; Pho-
tography; Sports Coverage; Sales Pro-
motion; and Community Leadership. 
Newspapers may also enter the digital 
media contest, but the results will not 
count toward the Sequoyah Award.

There are 11 contest categories that 
recognize individual work. Those are: 
News Story; Feature Story; Sports 

Story; In-Depth Reporting; Column 
Writing; Small Space Ad; Large Space 
Ad; News Photograph; Feature Photo-
graph; Sports Photograph; and Front-
Page Design.

All the information about the new 
categories and how to enter can be 
found on the press association website 
at www.okpress.com/contest.

If your newspaper is among the 60 
percent of OPA member papers that 
usually don’t enter the contest, I hope 
you’ll do it this year. It is a good chance 
to see how your paper stacks up against 
its peers and it’s a great way to get rec-
ognition for you and your employees.

It’s cheap – $10 per entry. Even if 
you don’t enter all the Sequoyah Award 
categories, pick a couple of categories 
where you think you do well. 

Even though I am sure that you – 
like me - enjoy winning stuff, the pur-
pose of the Better Newspaper Contest 
is to help us all learn and get better at 
what we do. 

And, by all means, spring for your 
staffers to enter their best work, as 
well. They’ll appreciate it and you might 
find yourself hanging their hardware up 
on the wall at your paper.

Changes to OPA contest offer 
more awards and digital entry

O

by Brian Blansett
 Publisher of the Tri-County Herald 
 2017-2018 OPA President

    On that
      note…

OPA LEGISLATIVE SUMMIT
THURSDAY, FEB. 8, 2018 

9:30 AM to 1:30 PM – FREE but please register in advance
All OPA members are encouraged to meet at the State Capitol on Feb. 8.  We’ll have a short group meeting 
in the Blue Room on the 2nd floor, across from the Governor’s office and behind the Governor’s conference 
room. Lunch will be provided by OPA in the 1st floor rotunda. Gov. Mary Fallin will speak to attendees at 
1 p.m.

OPA BETTER NEWSPAPER CONTEST 
ENTRY DEADLINE

MONDAY, FEB. 12, 2018 
There are lots of changes in the 2017 OPA Better Newspaper Contest. Most entries will be judged online as 
full-page digital tearsheets in PDF format. To submit contest entries, go to https://betternewspapercontest.
com/OPA. Entry materials that must be mailed (Categories 1, 2 and 3) must also be postmarked by the 
February 12 deadline. This year, 20 categories offer an opportunity for newspapers and staff members to 
be honored. Visit OKPress.com/Contest for more information.

WEBINAR: DESIGNING SPECIAL SECTIONS
THURSDAY, FEB. 15, 2018 

10 AM to 10:45 AM – COST: $39
Join Ed Henninger as he teaches newspapers how to design special sections that will make money and 
draw readers. Capitalize on your sections by learning tips to create more interest and advertising revenue. 
To register, visit newspaperacademy.com.

WEBINAR: VIDEO STRATEGIES
THURSDAY, FEB. 15, 2018 

1 PM to 2 PM – COST: $35
Video offers your audience a front row seat to history, a chance to feel as if they are intimately connected 
and an opportunity to deeply understand an issue. This session will help you decide what video strategies 
to adopt, what technology to use and how your entire staff can contribute video stories. To register, visit 
onlinemediacampus.com.

2018 OPA ANNUAL CONVENTION
FRIDAY & SATURDAY, JUNE 15-16, 2018

It’s never too early to start planning. Mark your calendars to join us for OPA’s Annual Convention at the 
Grand Casino Hotel Resort in Shawnee, Okla. 

OPA CALENDAR OF EVENTS

For more information on upcoming events, visit the OPA website at 
www.OkPress.com or contact Membership & Meetings Director Christine Frank 

at (405) 499-0040, 1-888-815-2672 or email CFrank@okpress.com.

An investigation is being sought 
against the Oklahoma Tourism and 
Recreation Department over allegations 
that it broke laws regulating employ-
ment practices, taxpayer funds and open 
records and meetings.

The Oklahoma Public Employees 
Association sent a written request for the 
investigation to Oklahoma State Attor-
ney General Mike Hunter, Oklahoma 
District Attorney David Prater and the 
House Special Investigation Committee.

“Oklahomans deserve to know if the 
agency disregarded merit protection 
commission and district court orders 
pertaining to the treatment of tour-
ism employees,” said OPEA Executive 
Director Sterling Zearley. 

“OPEA also has concerns about agen-
cy open records violations, the handling 
of a state auditor and inspector’s report 
and a federal Department of Labor inves-
tigation.”

OPEA asks for investigation 
of state tourism department

An attorney general opinion says a 
private organization of county sheriffs 
must make its meetings and certain 
records open to the public.

Oklahoma Attorney General Mike 
Hunter said the Oklahoma Sheriff’s 
Association is subject to state openness 
laws because it is “supported in whole or 
in part by public funds.”

State Rep. Bobby Cleveland, R-Slaugh-
terville, asked for the opinion after hear-
ing concerns about the association from 
journalists, The Oklahoman reported.

OSA must comply with the Open 
Meeting Act when a majority of its mem-
bers meet to conduct OSA business, the 

opinion states. It is also subject to the 
Open Records Act, but only for records 
involving “the transaction of public busi-
ness, the expenditure of public funds or 
the administering of public property.”

The opinion is based on the asso-
ciation’s paid administrative role in the 
Oklahoma Temporary Motorist Liabil-
ity Plan, which allows police to seize a 
driver’s license plate if the driver doesn’t 
have proof of insurance. To get the 
license plate back, the driver must pay a 
$125 fee, with $10 from each fee going to 
the Oklahoma Sheriff’s Association for 
administering the plan.

AG says sheriff’s association 
subject to open records law
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Brown family sells Stroud American 
to publisher of Tri-County Herald

The Stroud American is under new 
ownership.

Blansett Media Incorporated, which 
owns the Tri-County Herald in Meeker, 
purchased the weekly newspaper last 
month from Mike and Alicia Brown.

 “We are very pleased to pass the 
Stroud American torch to a great team 
who will bring fresh ideas, new energy 
and creativity to the forefront,” said 
Mike Brown. 

The Brown family had owned the 
American since 1973. Mike and Alicia 
Brown have been its owners and pub-
lishers since 1997.

The Browns said they have no plans 
to leave the Stroud community but will 
be pursuing other opportunities.

“The two and a half years that we have 

published the Herald has reinforced for 
me the importance of community news-
papers,” said Brian Blansett, publisher of 
the Herald and now the American.

“The Brown family has a tremen-
dous legacy in Stroud. I’m grateful they 
trusted our team enough to make this 
opportunity possible.”

Blansett, a veteran of the newspaper 
industry, currently serves as president 
of the Oklahoma Press Association.

Nicole Smith, who was an intern, 
employee and stringer for the Herald, 
is the news editor of the American and 
is working in the Stroud office. Salonne 
Carter, a Stroud native and veteran 
newspaper sales executive, will work 
part-time as a sales executive.

New owners, 
press days at 
Elk City News

Chisholm Trails LLC is the new 
owner of the Yukon Review and Mus-
tang News.

Yukon businessman Scott Myrick, 
Oklahoma City attorney Russell Mulinix 
and newspaper publisher John Settle are 
involved in the new company. 

Chisholm Trails acquired the proper-
ties from Star Communications, which 
has owned the Yukon Review since July 
1, 2015, and the Mustang News since 
Feb. 1, 2016.

“This agreement will not change the 
normal operations of the paper or its 
staff,” Settle said. “It will position the 
papers to be able to continue to grow 
with the communities.”

Myrick is the developer of the pro-
posed Thunder Falls indoor water park 
near Yukon. 

Mulinix is a Norman attorney and 
a longtime friend of Review publisher 
John Settle.

“I am very excited about the addition 

of Scott and Rusty,” said Settle. “Their 
vision and commitment to the future of 
Yukon and Mustang has ensured the 
two newspapers will be serving these 
communities far into the future.”

Myrick said he is excited about the 
new venture. He plans to be involved 
with the newspaper, but said that Settle 
will continue to oversee the day-to-day 
operations.

Mulinix, who also owns a Keller Wil-
liams franchise real estate agency in the 
Norman area, said community newspa-
pers are the internal fiber of the com-
munity.

Community newspapers, he said, are 
where readers find out what’s going on 
in their towns, whether it’s city council 
meetings or sports coverage.

The Yukon Review was founded in 
1963 and is a successor to the Yukon 
Sun, which was established before 1900. 

The Mustang News was founded in 
1982.

The Elk City News has new own-
ers after eight decades under direc-
tion of the Wade family.

Scott Wesner and Scott Wood, 
along with new publisher Josh 
Umholtz, became the new owners 
on Dec. 1.

“We are so excited to be a part 
of a long tradition at The Elk City 
News,” said Wesner. “Having grown 
up in Cordell, it’s great to be back 
home working in the same area we 
know best.”

Wesner and Woods both gradu-
ated from Cordell High School.

Wesner now lives in Austin, 
Texas, and has been in the newspa-
per business for 22 years. He is the 
father of two children, Hanna, 16, 
and William, 14.

Wood began his newspaper 
career in 1997 in West Texas. In 
2003, he moved to Muenster, Texas, 
and acquired three newspapers. 
Wood and his wife, Deborah, have 
two children, Emma, 18 and Sarah, 
9.

In addition to the newspapers 
they own individually, Wesner and 
Woods co-own additional papers in 
Dalhart, Texas; Coleman, Texas; 
Independence, Kansas; Coffeyville, 
Kansas; and Gothenburg, Nebraska.

Wesner said their main focus is 
“producing an excellent newspaper.”

“We’re looking forward to con-
tinuing the great tradition of com-
munity journalism,” he said.

Umholtz said some changes are 
being made to ensure the health and 
success of the newspaper.

The first change was becoming 
a two-edition per week newspaper, 
which began on Jan. 12.

With two publications per week, 
The Elk City News will become 
more robust, hyper-local and timely, 
Umholtz said. 

A new advertising team is in 
place at the newspaper to serve cli-
ents. Courtney Faylor was recently 
named advertising manager while 
Nancy Hylton returned to work part-
time.

Faylor has been working at the 
newspaper since July. Hylton is 
returning to The Elk City News 
for the fourth time. Both ladies are 
longtime area residents. Faylor and 
her family are moving to Canute, 
and Hylton has been an Elk City 
resident for many years.

Chisolm Trails LLC takes ownership 
of Yukon Review and Mustang News
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The McAlester News-Capital part-
nered with Ignite McAlester on a forum 
regarding school board candidates and 
sales tax proposals on the upcoming 
Feb. 13 election ballot.

“It’s our responsibility to present 
these forums to our community,” said 
News-Capital Publisher Amy Johns. “We 
want people to be able to make wise 
decisions when they go to the polls.”

Johns said candidates will be given 
opportunities for opening and closing 
statements, and will be asked questions 
presented by a panel from the News-
Capital.

Representatives from the City of 
McAlester were invited to speak regard-
ing the sales tax proposals.

Ignite McAlester is a young profes-
sionals network.

McAlester News-Capital plans 
candidate forum for community 

Cushing Citizen transitions to weekly
The Cushing Citizen has transi-

tioned to a once weekly print edition on 
Wednesday with a free electronic edition 
on Friday.

The change was effective Jan. 1, 2018, 
said David Reid, publisher of the Citizen.

“The staff is quite excited about this 
change,” Reid said. “The wide-open can-
vas of the Weekend electronic edition is 
fascinating to our team.

“We’ve got a pretty young staff and 
they are embracing this electronic prod-
uct better than I am. I have to admit, 
their enthusiasm is catching – even with 
me.”

The Wednesday Citizen remains the 
same subscription price, but the news-
stand price increased to 75 cents. 

Advertising packages for the elec-
tronic issue are being offered as a three-
month, six-month or weekly one-year 
agreement, said Reid.

“I think this Saturday electronic is 
going to far exceed the revenues of the 
previous Saturday print issues and at 
a fraction of the production cost,” said 
Reid. “We’re confident this is a positive 
move both for the company and for the 
community.”

Trail Miller Co., LLC welcomes Hay-
ley Grimes as the new assistant editor 
for The Okeene Record and The Canton 
Times. She will cover local news as well 
as help editor Lia Hillman with the news-
paper production. 

“There’s a lot that goes into produc-
ing a newspaper each week that people 
don’t always see,” Hillman said. “I’m 

excited for Hayley to learn all different 
aspects of this company.”

Prior to joining the staff at the Record 
and Times, Grimes worked as a courier 
delivering newspapers for The Houston 
Chronicle. She is originally from Lake 
Jackson, Texas, and  graduated from 
Texas A&M University in 2015 with a 
degree in agricultural communications 
and journalism. 

New assistant editor joins 
Trail Miller Co., LLC staff

The Oklahoman recently introduced 
its all-new lifestyle magazine that cel-
ebrates everything Oklahoma.

 “The OK” (like the tree) is a quar-
terly magazine that will cover people 
and places, food and fashion, travel and 
technology, and more.

It will also bring stories told in the 
unique voices of The Oklahoman’s 
reporters ranging from long-form nar-
ratives to in-depth reports as well as 
personal columns and tales.

The OK is a premium product for 
subscribers who can get it at a discount-
ed price as well as opt out if they’re not 
interested. The magazine is also avail-
able at premium outlets as well as online 
for $5.99. 

The inaugural edition, The Year in 
Pictures, highlights the work of the 
award-winning photography staff, head-
ed up by veteran Doug Hoke. 

Phil O’Connor is editor of The OK; 
Todd Pendleton is the creative director.

The Oklahoman launches magazine
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In Memory of Our Friends & Colleagues
John Yates

Dec. 10, 2016

James R. ‘Jim’ Bellatti
Dec. 13, 2016

David Lee Avery
Dec. 15, 2016

Laura Yvonne Holmes
Dec. 19, 2016

Ronald Michael ‘Ron’ Smith
Dec. 30, 2016

Bobby V. Hughes
Jan. 6, 2017

Mary Louise Frick
Jan. 11, 2017

David Allen Trammell
Jan. 16, 2017

Helen Barrett
Jan. 20, 2017

Herman Brown
Jan. 20, 2017

DEATHS
DAVID ALTMAN, a longtime Oklahoma 
jorurnalist, died Dec. 8, 2017. He was 71.

Altman was born Aug. 29, 1946, in 
Seminole and later moved to Wewoka 
with his family. He graduated from 
Wewoka High School in 1964, attended 
the University of Oklahoma and gradu-
ated from East Central State College in 
1969. 

 After his honorable discharge from 
the Army in 1972, Altman joined the 
Wewoka Daily Times as ad manager. A 
year later he joined the Wewoka Fire 

Department as a firefighter/emergency 
medical technician and spent his days 
off helping start The Wewoka Sun, a 
weekly newspaper. 

In 1979, Altman moved to Clinton 
where he helped start The Custer Coun-
ty Leader as a reporter before becoming 
editor then general manager. In 1984, he 
went to the Blackwell Journal-Tribune to 
serve as sports editor. Later that year, he 
began working at the Fairview Repub-
lican where he was promoted to editor 
in 1985. His career also brought him to 

the Nowata Star as editor before return-
ing to the Fairview Republican. In 2001, 
he left the Fairview Republican to start 
an e-mail newsletter, Fairview E-News. 
While still publishing E-News, Altman 
also joined the staff of the Enid News & 
Eagle as copy editor. He retired from the 
newspaper in 2008.

Altman is survived by his son Greg-
ory Michael Altman and wife Tina of 
Corpus Christi, Texas; daughter Melissa 
Dawn Altman of Oklahoma City; and two 
siblings.

NORA KATHRYN FROESCHLE, former 
reporter for the Tulsa World, died Dec. 
21, 2017. She was 49. 

Froeschle was born June 19, 1968, 
in Minneapolis, Minn. She worked as a 

liaison for veterans at Veterans Affairs 
in Washington D.C. before serving 10 
years as a reporter for the Tulsa World. 
She later began a career as an English 

teacher at Union High School and Sand 
Springs’ Clyde Boyd Middle School. 

Froeschle is survived by her two sons 
Jared Cole Froeschle and Christopher 
Robin Silberstein.

THANK 
YOU

to the following individuals 
and organizations for their 

recent donations to the 
Oklahoma Newspaper 

Foundation:

Andy & Karen Rieger

Trail Miller Co.

In memory of Ray Lokey
Betty Boyd

A donation to the Oklahoma 
Newspaper Foundation will 
support its efforts to improve the 
state’s newspaper industry and 
quality of journalism. 

ONF’s programs include training 
and education for professional 
journalists, scholarship and 
internship programs for 
journalism students, and 
Newspaper in Education efforts. 

ONF relies on donations and 
memorial contributions to fund 
these programs. 

If you would like to make a 
donation, please send a check to: 

OKLAHOMA 
NEWSPAPER 
FOUNDATION

3601 N. Lincoln Blvd.
Oklahoma City, OK 73105

The Donald W. Reynolds Journalism 
Institute invites proposals from people 
and organizations who wish to partner 
with them on innovative projects that 
strengthen democracy through better 
journalism.

Successful projects often include 
devising new strategies to take advan-
tage of an opportunity or solve a prob-
lem, building new tools for news orga-
nizations, transforming an idea into a 
market-tested prototype or advancing a 
prototype so it’s ready for investment or 
a full product launch.

Whatever your idea, its benefits 
should extend to other news organiza-
tions and the people who depend on 
them. To apply, please clearly describe 
your experience, relevant connections 
and expected outcomes during and 
immediately following your fellowship 
year.

There are three types of RJI Fel-
lowships: residential, nonresidential and 
institutional.

• RESIDENTIAL FELLOWSHIPS are 
designed for persons, inside and outside 
media industries, who want to collabo-
rate with RJI in the pursuit of solutions 
to a particular journalism problem. 

Residential fellows spend eight 
months on the University of Missouri 

campus, receive an $80,000 stipend and 
a $10,000 one-time housing or relocation 
allowance.

Solutions – in the form of strategies, 
products or services – developed from 
these ideas would be shared with many 
news and news-related organizations. 
You must reside in Columbia, Missouri, 
for the duration of this fellowship.

• NONRESIDENTIAL FELLOWSHIPS are 
designed for entrepreneurial individuals 
with a strong interest in journalism and 
issues related to digital communications. 

Your fellowship can be about some-
thing you are interested in pursuing on 
your own or something that could bene-
fit a current employer. Successful ideas, 
products or strategies should serve as a 
model for the news industry or help the 
industry get smarter, faster and nimbler. 

You do not need to live in Columbia 
but you will need to make occasional 
visits to consult with RJI leadership and 
staff. 

Nonresidential fellows receive a 

$20,000 stipend, plus research and travel 
support.

• INSTITUTIONAL FELLOWSHIPS are 
designed to unlock some of the thought-
ful, meaningful ideas inside newsrooms, 
ad departments, boardrooms and break 
rooms that for various reasons can’t get 
any traction. 

RJI will collaborate with a leader at a 
company or institution who will identify 
an employee who can develop an idea or 
lead a team that could do it. The employ-
ee will be named an RJI Fellow but will 
continue working at his or her job. The 
institutional fellowship stipend – $20,000 
– is paid to the company or organization 
and can be used for salary relief or for 
another purpose to best ensure the suc-
cess of the fellowship project.

RJI Fellowships are open to U.S. citi-
zens and news organizations as well 
as international news outlets.  RJI also 
welcomes proposals from international 
journalists who plan to partner with 
U.S.-based news, technology and civil 
society organizations.

The deadline to apply is midnight 
CST on Jan. 31, 2018.

For more information or to apply, 
go to https://www.rjionline.org/stories/
apply-now-for-2018-2019-rji-fellowship.

Apply now for a 2018-2019 RJI Fellowship
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Dale junior Lacey Savage gets the heroine’s welcome after scoring the 
winning basket at the buzzer against Latta.

Photo by RICK HESTER, Tri-County Herald, Nov. 17, 2017

NOVEMBER 2017 
WEEKLY WINNER: 

RICK 
HESTER

Tri-County Herald
NOVEMBER 2017 
DAILY WINNER:

JASON 
ELMQUIST

Stillwater News Press

The November 2017 
contest was judged by a 

member of the 
Oklahoma Journalism 

Hall of Fame.

View all winning photos at 
www.OkPress.com/
OGE-Photo-Contest

ENTER AND WIN A 
$100 CHECK FROM 
OGE ENERGY CORP. 

For more information 
about the photo 

contest, visit 
www.okpress.com/
oge-photo-contest

Oklahoma State senior quarterback Mason Rudolph dives over the pile into the end zone for a touchdown 
against Kansas. It was his 45th touchdown of the year, moving him ahead of Barry Sanders for the program 
record of touchdowns in a season.

Photo by JASON ELMQUIST, Stillwater News Press, Nov. 26, 2017
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 BY JOY HAMPTON
 Senior Staff Writer for The Norman Transcript (Reprinted with permission)

Calls to prayer, mountain vistas, verdant valleys 
and aromatic curries are just a few of the sen-
sory memories I have of trips I’ve made to Paki-

stan and Bangladesh. The trips were media exchanges 
made possible by U.S. State Department grants and a 
University of Oklahoma program to foster friendly rela-
tions with journalists in emerging nations.

When Sheikh Rokan, an environmental journalist 
from Dhaka, Bangladesh, spent time shadowing me 
and working at The Transcript back in 2013, little did I 
know I would be invited to visit his nation in return as 
part of the media exchange.

That January 2014 trip to Bangladesh was a life-
changing experience. I learned how much we have in 
common with journalists around the globe, but I also 
learned how challenging some of their struggles are.

One of my strongest memories in Bangladesh was a 
visit to a newsroom where journalists described escap-
ing from their previous offices in a burning building 
where many of their fellows perished.

While Dhaka, with a population approaching 20 
million, has building and fire codes, they are seldom 
enforced, the people there told me.

Recently, I returned to the Indian subcontinent of 
South Asia again with an Oklahoma media delegation, 
this time to meet with journalists in Pakistan. 

I had met with some of them previously during 
their visits to Norman and was privileged to be able 
to tell the story of one vibrant young female reporter, 
Shaista Hakim, who courageously bucked stereotypes 
to report from the Swat valley region, an area particu-
larly dangerous for reporters.

Hakim was the first female journalist in Swat and has 
been recognized with awards for her work.

On this trip, I met her fiancé, who is also a journalist, 
during a visit to the National Press Club in Islamabad, 
Pakistan. During the visit, I saw a monument built in 
tribute to journalists who lost their lives on the job.

Every year, journalists in Bangladesh and Pakistan 
face grave dangers, being shot in the crossfire during 
dangerous assignments or murdered because they are 
doing their jobs. It’s a danger unprecedented where I 
work in Norman, where the greatest censure I usually 
face is criticism via social media.

Standing in front of that monument with reporters 

who face danger daily and do their jobs anyway was 
a sobering moment and one which prompted deep 
reflection.

Would I have the courage to report the truth when 
and where it mattered most, even if it put my life in 
danger?

Hopefully, I will never know the answer to that ques-
tion, but asking the question gave me new respect for 
those who dare to report the news in turbulent nations. 
The dangers they face, along with the need and desire 
for better training and higher professionalism is why 
programs like the one sponsored through OU exist.

Since 1992, 21 journalists working in Bangladesh are 
confirmed to have been killed as a result of their jobs, 
according to the Committee to Protect Journalists, a 
watchdog organization that tracks journalist deaths. Of 
those, two died as a result of dangerous assignments. 
The rest were murdered.

In Pakistan, 60 journalists have been killed since 
1992, according to the CPJ, while seven American jour-
nalists were killed in the same time frame.

The danger disparity becomes even more remark-
able when you consider that the estimated population 
of the United States is 323.1 million compared to 163 
million for Bangladesh and 193.2 million in Pakistan.

For the second year in a row, the number of journal-
ists jailed worldwide has hit a high, with the lion’s share 
of those behind bars being in Turkey, China and Egypt, 
according the CPJ.

In recent years, Syria has been the most danger-
ous place to be a journalist, though that number has 

declined as the number of journalists in Syria has 
declined, CPJ reports.

Pakistan is a beautiful country full of people who 
were hospitable and welcoming. If there was a primary 
message they wanted to convey to Americans, it is that 
most Pakistanis are not terrorists. 

They are mothers, daughters, sisters, wives, hus-
bands, fathers and sons. They are a people connected 
by deep family and community bonds who want to 
live in peace and safety, but there are portions of their 
nation caught up in turmoil and conflict where simply 
reporting the truth is often seen as taking sides, put-
ting journalists in danger from extremist factions and 
sometimes imprisonment by governments who report-
edly support freedom of the press.

In the United States, we are threatened with lack of 
access, not the loss of our lives, but perhaps there is a 
lesson here.

When President Obama visited Moore following the 
2013 tornado, I was privileged to join the press corps 
that followed him from Washington, D.C. 

Sitting in the van with reporters from major publica-
tions like The Washington Post, The New York Times 
and Reuters, I was shocked when they told me that 
each presidential administration locks them out more 
than the last, that the news released from our nation’s 
capital is very controlled, that local newspaper report-
ers with our boots on the ground are the only real 
sources for getting at the truth in this day and age.

What am I willing to sacrifice to get at the truth?
Time to ponder some more.

Journalists pay high price to report truth

Norman Transcript reporter Joy Hampton takes a selfie 
outside of a mountaintop café near Islamabad, Pakistan. 
Hampton was one of a delegation of 10 journalist who 
traveled to Pakistan in December as part of a media 
exchange through the University of Oklahoma courtesy 
of a grant from the U.S. Department of State.

Former University of Oklahoma journalism dean Joe Foote (center) poses for a photo with journalist Riaz Gul and Gul’s 
family at the press club in Islamabad, Pakistan. (Photo by Joy Hampton/The Norman Transcript)
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What are your New Year resolutions 
for your newspaper? What are you going 
to focus on? 

Survival, obviously. Bottom line is 
more than just advertising. It still means 
attracting readers, more difficult than 
ever these days.

So, what stories are you going to 
tell this year? How are you going to tell 
them? It’s still about writing, effective 
writing – always will be.

Here are some tips from the past to 
be your resolutions for writing this year.

From “A Few Pointers,” in a hard-
bound 51-page 1936 Copy Desk and 
Reporters’ Manual for The Daily Oklaho-
man and Oklahoma City Times:

“Never let the lead paragraph run 
more than 50 words. Ten or 20 words 
are preferred.

“The Oklahoman and Times are read 
in homes where the average education 
is not above high school grades. Thus, 
the copy should be written in simple 
language.

“Try to answer in each story all ques-
tions the incident is likely to arouse 
in the reader’s mind. Tell who, what, 
where, when, why and how. Don’t leave 
a big question mark sticking out of the 
printed page to pique the reader’s curi-
osity.

“Never fail to include all names that 
have relation to the incident. Names are 
news. Get both sides. One side is only 
half a story. Be fair.

“Handle every story as though the 
principals were personal friends of 
yours.

 “Avoid formula leads. Snap it up by 
getting action in the first line and clean 
up the story in the lead in the shortest 
possible space. Get the feature angle. 
Color, spice and human interest are to 
be sought eagerly.”

Or, the first item from a much earlier 
style guide of the Kansas City Star, on 
one legal size piece of paper, three col-
umns, in six-point type:

“Use short sentences. Use short first 
paragraphs. Use vigorous English. Be 
positive. Not negative.”

Oh, a young reporter got his start 
there, following this advice. His name 
was Ernest Hemingway.

Oh, my resolution for this column. 
Take my own advice, write shorter, 
show more.

LOOKING’EM OVER. I think most Christ-
mas and end-of-year coverage in news-
papers is boring, front pages covered 
with big Christmas posters or text-heavy 

recaps of the past year. Some do use 
photos to help out, but little is used to 
really grab readers. (I know, it’s called 
fill the paper up easily so we can have a 
little time off.)

Exceptions. The Hooker Advance. 
Sheila Blankenship uses an attention 
getter and writes about it, with photos. 
Her lead:

“This past year seemed to have been 
12 months of extremes locally as the 
brand new state-of-the-art wind tur-
bine erected by BarberWind collapsed 
unexpectedly this summer even as the 
88-year-old Adams elevator still defies 
gravity as it sways with the wind but 
remains upright.”
• Tulsa World’s photo editor John Clan-

ton (bragging here on former student 
and UCO grad), writes about the pho-
tos of the year, with three pages of top 
photos, headlined, “Worth a thousand 
words.”

• Claremore Daily Progress, Tom Fink 
interviews city leaders about their 
resolutions. 

• The Mooreland Leader, Christmas edi-
tion, front page photos and poems of 
sixth graders.

• The Canton Times, historian Max 
Nichols writing, “One for the Okla-
homa History Book.”
Newspapers doing what they’re sup-

posed to:
• The Oklahoman – Matt Peterson on 

disabled people’s problems at Will 
Rogers Airport, “Curbside Conun-
drum.”

• The Oklahoma Eagle – Margaret 
Hicks, on nursing home problems, 

“Cherokee Meadows: Things Go 
Boom In The Night” 

• Tulsa World – Ginnie Graham, putting 
faces on a shelter for special needs 
children scheduled for closing, “Kids 
in Crisis.”

Congratulations:
• Cheryl Overstreet, named editor as 

she starts her 24th year at The Elk 
City News.

• Sharp new design at the Durant Demo-
crat and Altus Times.

• Tonkawa News celebrates 124th year.
Story ideas you can localize:
• The Shawnee News-Star, Vicky O. 

Misa, on a local holiday icon. What 
are the icons and landmarks in your 
area?

• Beckham County Record, Shonda Lit-
tle, “Opioid crisis reaches western 
Oklahoma.”

• The Konawa Leader, Josh Allen, 
national survey shows religious 
“nones” growing – interview more 
than pastors.

HEAD’EM UP AWARDS.
First place, tie, The Oklahoman, on 

Nate Billings’ photo of Baker Mayfield 
walking off field after Rose Bowl loss:

WILTED ROSE
The Black Chronicle, on John W. 

Simms story about a family suing over 

another death in the Oklahoma County 
jail:

WHY THE KILLINGS?!
Second place, Claremore Daily Prog-

ress, on Cydney Baron story about a 
rezoning request:

BETWEEN A ROAD AND A HARD PLACE
Third place, Guymon Daily Herald on 

Carol Perea story about police beards/
fund raising effort:

GUYMON POLICE ARREST SHAVING
Her lead: “…you will not be arrested 

for shaving, but local officers jailed their 
razors for a good cause.”

Honorable mentions: Guthrie News 
Leader, “Christmas delivery: 211 pairs of 
shoes,” Mike Monahan about donations 
to Coyle elementary students; Minco-
Union City Times, “Butcher’s Block: A 
Cut Above,” Jayson Knight story about 
a store; The Ardmoreite, “Good Clean 
Fun,” Rhiannon Saegert story about a 
school anti-litter poster contest; Okmul-
gee Times, “Winter Woes,” Kaitlyn Dil-
lard photo of cold weather impact; The 
Lawton Constitution, “Students take their 
best aim,” Grace Leonhart about an 
archery competition; The Norman Tran-
script, “Cash, Candidates and Cannabis,” 
Adam Troxtell on the legislative future.

Clark’s Critique
by Terry M. Clark

Journalist
tmclark44@gmail.com 

@okieprof

Tips from the past for your writing resolutions

Featured this month are the Okmulgee Times, Minco-Union City Times, The Shawnee 
News-Star, The Konawa Leader, The Canton Times, The Mooreland Leader, The Hooker 
Advance, The Oklahoma Eagle and The Oklahoman.

By KAITLYN DILLARD

Times Staff

Extension Educator Leslie
Lewis is excited to bring her
agricultural knowledge to
OSU Extension Office with
hopes of new programs. 

Lewis had an early back-
ground in agriculture,
growing up in Cushing on a
dairy farm. Taking her
interests to college, she
graduated from OSU with a
Bachelor’s degree in animal
science and agricultural
communications and a

Master’s degree, also from
OSU, in agriculture educa-
tion. 

Previously, Lewis had
been using her talents as a
full-time 4H Educator at a
Tulsa Extension office
before she accepted her job
at OSU Extension Office in
November. 

Lewis has always been
interested in helping peo-
ple. 

“What brought me to
extension was the fact that I
knew that I could make a
difference and work with
people in the community to
help them make a differ-
ence in their agricultural
production,” Lewis said. 

“I have always had a

heart for serving people and
working with people, so I
like the day-to-day interac-
tions with people that come
through the door.”

In her position at the OSU
Extension Office, Lewis
faced some differences
between an urban exten-
sion office to rural exten-
sion office. A big program in
Tulsa at her previous job
was the Master Gardner
program, while Lewis has
had to delve back into her
roots at the dairy farm. 

“I am really excited to get
back to a rural county and
community and being able
to work with the people
that I grew up with.”

As of right now, Lewis
hopes to learn as much as
she can so she can better
serve the agriculture pro-
ducers located in Okmulgee
County. 

She also hopes to start a
new program called the
Master Gardner program
that is set to debut in this
fall. 

“I definitely want to be an
open door to the communi-
ty,” Lewis said. 

The OSU Extension Office
offers a variety of programs
and services to the whole
community in regards to
agriculture from cattle to
produce to even what type
of bug is in a resident’s gar-
den. 

Inaugural ceremonies for the Muscogee
(Creek) Nation will be held on Saturday,
Jan. 6. The ceremony will begin at 10 a.m.
in the Mound Building Auditorium in the
Capitol Complex.

The inauguration is being held during a
Special Session called by the current
Speaker of the National Council, Lucian
Tiger III. The Legislative Branch  will take
the Oath of Office for the Pale-Svhokkolat
(20th) Session of the Muscogee National
Council. Supreme Court Justice Amos

McNac  will conduct the Oath of Office.
The following representatives were certi-

fied by the records of the Muscoge Nation
Election Board for the 20th Session (2018-
2019) of the Muscogee  National Council:

Creek District 
Seat A - Del Beaver 
Seat B - Patrick Freeman, Jr.  
Okmulgee  District
Seat A - David Hill  
Seat B - James Jennings 
McIntosh District 

Seat A - Darrell Proctor
Seat B - Adam Jones III    
Tukvpvtce District
Seat A – Rufus Scott
Seat B – Thomasene Yahola Osborn
Muskogee District
Seat A - Pete Beaver 
Seat B – Joyce C. Deere 
Tulsa District
Seat A - Robert Hufft
Seat B – Lucian Tiger III
Okfuskee District   

Seat A – Randall Hicks 
Seat B – Travis Scott 
Wagoner/Roger/Mayes District
Seat A - Johnnie Greene Seat B – Mark

Randolph
The Muscogee (Creek) Nation is one of

the largest Indian tribes in the United
States with the original boundaries cover-
ing eight counties in northeastern
Oklahoma and a tribal enrollment of
84,417 (as of Dec. 5, 2017).

By PATRICK FORD

Times Editor

A county man has been
sentenced to 14 years in
prison for child pornogra-
phy.

John Carl Berryhill, 53, of
Okmulgee, was sentenced
to 168 months imprison-
ment, and life supervised
release for Possession Of
Certain Material Involving
The Sexual Exploitation Of
Minors.

The United States
Attorney’s Office for the
Eastern District of
Oklahoma announced the
sentence this week.

The indictment alleged
that from between on or
about January 8, 2014, to
February 2, 2017, Berryhill,
“did knowingly possess,
attempt to possess and
access with intent to view,
matters which contained
visual depictions, as that
term is defined in Title 18,
United States Code, Section
2256(5), which said visual
depictions involved the use
of minors engaging in sexu-
ally explicit conduct, as that
term is defined in Title 18,
United States Code,
Sections 2256(2)(A)-(B),
and said visual depictions
were of such sexually
explicit conduct and had
been transported in inter-
state commerce by comput-
er.”

An investigation by the
Federal Bureau of
Investigation led to the
charges against Berryhill.

“Berryhill’s sentence not
only brings him to justice,
but should serve as a warn-
ing and deterrent to others
who might consider pos-
sessing child pornography,”
United States Attorney
Brian J. Kuester said.  “The
FBI and the United States
Attorney’s Office are com-
mitted to investigating and
prosecuting those that
exploit children, including
those that possess, share, or
view child pornography. I
commend the FBI agents for
their thorough and profes-
sional investigation, and the
members of this office who
worked diligently to prose-
cute Berryhill.”

The Honorable Ronald A.
White presided over the
hearing. Berryhill will
remain in custody pending
transportation to the desig-
nated federal facility at
which the nonparoleable
sentence will be served.

Assistant United States
Attorney Edward Snow rep-
resented the United States.

Each year, Oklahoma
Magazine select its top five
Oklahomans, Principal
Chief James R. Floyd is
among the elite list. 

“The recognition honors
Oklahomans who have

enriched the state’s fabric
through contributions to
business, policy, arts, and
entertainment, public serv-
ice, cultural preservation
and more,”  Vida Schuman,
publisher and editor of OK

Mag,  said.
This is Floyd’s second

year of his first term as prin-
cipal chief of the fourth-
largest tribe in the nation.

“This is such a great
honor and a pleasant sur-

prise,” Floyd said. “I came
into office not trying to
make a name for myself,
but to put the tribe back on
top. So this is a very hum-
bling accolade.”

OK Mag said its staff,

which includes the publish-
er and editors, research
carefully to choose
Oklahomans of the Year,
“the people we feel have

Creek Nation to hold inauguration Saturday

Countian
sentenced in

porn case

Principal chief receives honor from OK Mag

See Chief on page A2

County OSU Extension acquires new educator
Leslie Lewis excited to bring 

new programs

Leslie Lewis

By PATRICK FORD

Times Editor
The Okmulgee Martin Luther King Jr.

Commemorative Planning Committee has
finalized plans for this year’s program.  

This year’s theme is “The Color of Unity.”
On Thursday, Jan. 11, Okmulgee area

schools will hold their programs for stu-
dents.

Naomi Kiett of Tulsa’s Fox 23 will be the
guest speaker at 9 a.m. at Brock Gym on
the Okmulgee High School Campus. Rae
Ann Wilson will be the speaker at the
Okmulgee Primary School at 9 a.m. and
9:45 p.m. programs. Dunbar Elementary
will hold their program at 1 p.m. Rev.
Terence Reed is the scheduled speaker.

On Friday, Jan. 12, Stonebridge Academy

will host guest speaker Donnie Alexander
for their Martin Luther King Jr. program at
8:15 a.m.

The MLK Jr. Commemorative Banquet
will be held on Saturday, Jan. 13 at the
State Room on the campus of OSUIT at
6:30 p.m. The guest speaker will be Dr.
George E. Young, Sr., State Representative
for House District 99.

On Sunday at 3:30 p.m., there will be a
youth program at the St. Matthew Baptist
Church, located on Chicago Street at Wood
Drive.

To cap off the events, Rev. McKinley Rice
will address attendees at the MLK Jr.
Program at St. Matthew Church at 7 p.m.

See Wednesday’s edition for more infor-
mation about the programs and speakers.

The Color of Unity
Plans finalized for MLK Jr. programs, banquet 

Dr. George E. Young, Sr.,
State Representative for
House District 99, will be
the guest speaker at the
MLK JR. Banquet on Jan.

13 at the OSUIT State
Room.

See more Front Pages on Page 9
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SHAWNEE AREA MANHUNT

Suspect hides in river, gets hypothermia
By Kim Morava
kimberly.morava@news-star.com
@Kim_NewsStar

A suspect who tried to hide 
in the river during a manhunt 
Friday northwest of Shawnee 
ended up in the hospital for 
treatment of hypothermia, 
deputies said.

Pottawatomie County 
Undersheriff Travis Palmer 
said deputies apprehended 
Christopher L. Goodman, 
30, from the cold water and 
he was transported to the 
hospital with symptoms of 
hypothermia.

The manhunt began just 
before noon in an area near 

Brangus Road and Westech 
Road.

Deputies responded after a 
concerned citizen observed a 
vehicle stuck in the area and a 

the citizen down. 
Once on scene, deputies 

discovered the vehicle be high 
centered on the river and the 

occupant ran northbound 
along the river. 

Palmer said the vehicle 
was reported  stolen from 
Oklahoma City. A manhunt 
commenced, with nearby 
North Rock Creek School also 
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Among well-estab-
lished local traditions, 
one has earned its 
reputation as an annual 
staple of the Christmas 
season — shining down 
on Shawnee residents 
for more than eight 
decades. Anchored 
atop a 90-foot elevator 
at Shawnee Milling 
Co., the simple, yet en-
during feature greets 
area residents each 
December.

In 1935, the 26-foot 
tall, 14-foot wide 
Christmas star was  
placed high above the 
mill’s employees –– and 
has been perched there 
ever since.

THE MILL
A year before state-

hood –– in 1906 — 

when Shawnee was just 
11 years old, J. Lloyd 
Ford bought Shawnee 
Roller Mills.

Ford changed the 
businesses’ name to 
Shawnee Milling Co. 
and transported it 
north, across the North 
Canadian River, to the 
site where the compa-
ny stands now.

After much success 
and expansion, the 
company was dealt a 
tragic blow on Aug. 
11, 1934, when the mill 
burned to the ground; 
the loss was estimated 
to be around $300,000.

Without hesitation, 
Ford immediately gath-
ered his employees 
and hired them to clear 
the site –– and just nine 
months later Shawnee 

Milling rose from the 
ashes, celebrating with 
a three-day dedication 

in June of 1935 — just 
months before the star 
was added.

SEDF/CHAMBER 
OF COMMERCE

January 
vote set 
over  
proposed 
merger
By Vicky O. Misa
Vicky.misa@news-star.com
(405) 214-3962
Twitter: @Vicky_NewsStar

A proposed merger 
between the Shawnee 
Economic Foundation 
Development (SEDF) and 
the Greater Shawnee Area 
Chamber of Commerce has 
been pushed back a few 
weeks to be sure the process 
is being navigated properly.

SEDF Executive Director 
Tim Burg said a special call 
meeting originally planned 
for SEDF unit holders Fri-
day was changed to Jan. 10 
to ensure SEDF is in full 
compliance and is following 
the correct steps.

“Attorneys working on 
the proposed merger had 
determined that we were 
not in compliance with the 
State Statutes tied to dis-
solution of a organization 
such as the SEDF,” he said.

The SEDF’s by-laws — 
which are several decades 
old — didn’t align with the 
state guidelines, which re-
quire that no special call 
meeting can be held until 
after a 20-day period from 

-
tion date), Burg said.

“The State Statutes are 
what our leadership will be 
following, rather than the 
SEDF by-laws,” he said.

The State Statute also re-
quired that the meeting had 
to be held no later than 40 

date, Burg said, so leader-
ship tapped on the brakes 
a bit and rescheduled the 

The star atop an elevator at Shawnee Milling Co.
VICKY O. MISA STAFF PHOTO

CHRISTMAS

Shawnee icon still burns bright

COMING   IN PRINT

• Movies showing
See Friday’s paper for
a list of movies that will
be showing in Shaw-
nee.

WEATHER

TODAY SUN MON

62°/45° 57°/38° 61°/43°
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selection, service and value close to home!

Looking for that last 
minute gift? Have we 
got ideas for you! And, 
look who’s local!

Check it out inside!
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FRIDAY NIGHT 
BASKETBALL
ACTION

Goodman

Fallin issues 
special session 
call for Oklahoma 
lawmakers

OKLAHOMA CITY (AP) 
— Gov. Mary Fallin has 
issued her formal call for a 
special legislative session, 
asking lawmakers to return 
to the Capitol on Monday to 
address a $110 million hole 
in the current budget.

In an executive order 
released late Friday, Fallin 
said she was limiting the 
scope of her call to patch 
a budget overrun at the 
Oklahoma Health Care 
Authority.

Fallin and the Republi-
can-controlled Legislature 
failed to agree on a tax-in-
crease plan to stabilize the 
state budget and increase 
teacher pay during a recent 
eight-week special session. 
A package of tax hikes on 
tobacco, fuel, alcohol, and 
oil and gas production 
that would have funded a 

votes short of the 75 percent 
majority required for a tax 
increase.

Tax bill heads for 
passage as GOP 
senators fall 
in line

WASHINGTON (AP) — 
After weeks of quarrels, 
qualms and then elev-
enth-hour horse-trading, 
Republicans revealed the 
details of their huge nation-
al tax rewrite late Friday 
— along with announce-
ments of support that all 
but guarantee approval 
to give President Donald 
Trump the Christmas leg-
islative triumph he’s been 
aching for.

The legislation would 
slash tax rates for big busi-
ness and lower levies on 
the richest Americans in 
a massive $1.5 trillion bill 
that the GOP plans to mus-
cle through Congress next 
week before its year-end 
break. Benefits for most 
other taxpayers would be 
smaller.

“This is happening. Tax 
reform under Republican 
control of Washington is 
happening,” House Speak-
er Paul Ryan of Wisconsin 

in a conference call. “Most 
critics out there didn’t think 

1570 S. Gordon Cooper Dr. • Shawnee
878-4850
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BY MATT PATTERSON
Staff Writer
mpatterson@oklahoman.com

Bob Allen has always been some-
one who can handle tough situa-
tions. He saw combat in Vietnam, 
ran a business and with the help of 
his guide dog, Shirley, gets around 
as good as anyone without sight 
could hope for.

But when Allen finds himself 
negotiating small- and mid-sized 
airports, like Oklahoma City’s Will 
Rogers World Airport, he and Shir-
ley often meet their match.  

Allen travels frequently. When 
he flies with his wife, there are no 
problems. But when he takes a taxi or 
Uber to Will Rogers, things become 
more difficult. His preferred airline 
used to have staff available to get him 
from the curb to the checkout coun-
ter. But now, all but one carrier serv-

ing Oklahoma City no longer provide 
curbside assistance to handicapped 
and elderly passengers. As good as 
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Capitol Bureau
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A stretch of highway 
linking Oklahoma City 
and Edmond will close for 
three days this month, 

affecting commuters 
and other travelers along 
Interstate 235.

The Oklahoma Depart-
ment of Transportation 
has scheduled the closure 
for Saturday Jan. 20 until 
the following Monday so 

crews can move a pair of 
new railroad bridge spans 
in place. Winter weather 
could delay the closure by 
at least a week.

The bridge replace-
ment is part of the I-235 
and I-44 interchange 

project, which is still 
years from completion. 
The highway construc-
tion project’s final phase 
is expected to begin in 
2020.

Work along the highly 
traveled route forced 

a highway closure in 
June, but the contrac-
tor finished work quickly 
enough that the highway 
reopened sooner than 
expected. Two more 
closures are planned for 
the interchange after the 

bridge is moved.
Over three days,  two 

44-foot high,  275-foot 
long spans will be lifted, 
moved and placed into 
position above the

I-235 to close for three days

For some disabled travelers, getting around 
OKC’s Will Rogers World Airport can be a problem

Airline travelers wait in the terminal for their planes to arrive at Will Rogers 
World Airport. [PHOTO BY CHRIS LANSBERGER, THE OKLAHOMAN]

Oklahoma City resident Bob Allen, who 
is blind, has had difficulty when travel-
ing alone at Will Rogers World Airport 
and other mid-sized airports around 
the country when it comes to getting 
from the curb to the counter. [PHOTO BY 

CHRIS LANSBERGER, THE OKLAHOMAN]

CURBSIDE 
CONUNDRUM

BY K.S. MCNUTT
Staff Writer
kmcnutt@oklahoman.com

SHAWNEE — Eight weeks 
after the announced clo-
sure of St. Gregory’s Uni-
versity, many displaced 
students have enrolled 
at new schools, but the 

spring semester outlook 
is much bleaker for the 
former faculty.

Michael Scaperlanda, 
president of the  liberal 
arts college when it closed 
last month, said many 
students have transferred 
to the University of Okla-
homa, University of Cen-

tral Oklahoma and Okla-
homa Baptist University. 
Others, who wanted to 
continue a Benedictine 
liberal arts education, 
have enrolled at Benedic-
tine College in Atchison, 
Kansas, he said.

“The students, I think, 
are well placed,” Scap-

erlanda said. “They seem 
pretty happy with these 
decisions.”

In its final semester, 
SGU had 656 degree-
seeking students, said 
Theresa Bragg, who 
was executive assistant 
to the president. Some 
completed their degree 

requirements and gradu-
ated Dec. 1, but most will 
have to continue their 
education elsewhere.

Bragg said represen-
tatives from 65 colleges 
came to campus for 
transfer fairs following 
the Nov. 8 announce-
ment that the university 

no longer could afford to 
sustain operations.

“All the institutions in
Oklahoma were good,” 
she said. Oklahoma Bap-
tist University, located
nearby, stepped up as the 
record depository for St. 

Students move on, but jobs scarce for St. Gregory’s faculty

[THINKSTOCK PHOTO]

Fashion a 
la mode
Woman 
brings style 
expertise to 
new Paseo 
boutique.
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By Sheila Blankenship
 The past year seemed to have 
been 12 months of extremes lo-
cally as the brand new state-of-
the-art wind turbine erected by 
BarberWind collapsed unex-
pectedly this summer even as 
the 88-year-old Adams elevator 

with the wind but remains up-

-
ible sorrow at the death of a 

-

-

way to an extremely dry fourth 
quarter with 12 weeks with just 

 2017 was an historic year for 
the nation and the world but the 

-

center of the Oklahoma Panhan-
-

lines are worth the time before 
the history book slams shut on 

January
 

review of the environmental as-
sessment on Texas County land 

and the county assessor offered 
community assessment clinics 

-
ball action  with four wins  over 
Guymon while the Turpin area 
square dancers started a new se-

of the Merritt Tournament but 

 The Tyrone Bobcats claimed 
the Cherokee Tournament while 
county 4-H members took to the 

-

-
ored by her family and friends 

 The Jupiter ice storm left its 
-

tive ice that appeared lacy and 

-

-

cents while the Hooker Cham-
ber of Commerce welcomed 

were named All-Conference 

-

 Blue for Blad allowed the lo-
cal community as well as other 
schools to pour out love and 
concern for the family of Bladi-

and killed by a vehicle while 

 Elementary teachers played 
with students and their fami-

scholarships at the Guymon 

-

Jamie Anderson won the Miss 

 Briza Mesta was crowned 

queen while Tyrone seniors 

-

 Hundreds of people feasted 
-

er and onions and more at the 
United Methodist Church 80th 

February
 FFA’ers and 4-H Club mem-

-

 Hardesty juniors Taylor 

were crowned at the Bison 

-

 The community returned 

Gilmore in a fundraiser lun-
cheon to help with her medical 
expenses while a retirement re-
ception honored Keith Herald 
who had served as an employee 
of TCEC and a volunteer on the 

 Jack Perkins retired  from 
TCEC and was honored with a 
retirement party at the local co-

Bobcats claimed dual district 
basketball crowns while the 

Hooker third and 
-

er Club won their 
own basketball 

Doers 4-H Club 

McDonald House 

for the Ward #2 
seat on the Hook-
er City Council 
while no one 
could defeat the 

teams as they 
claimed district 

-

-
vanced to the 

won honors in 
the Texas County 

-
rell Grandy and 
Dennis Voth won 

by the Hooker 
-

 The City of 
Hooker and the 
Hooker City 

were awarded 

-
ed a Valentine’s Day taco din-

scholarships and the Thrivent 

-
tion of Conservation Districts 
when he was named Outstand-

-

 He was honored for his com-
mitment to national resources 

The
HOOKERAdvance

The
HOOKERAdvance

Happiness Is...
remembering

the best of 
2017!

 Mollie Noyes takes aim 
at the basketball goal in 
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“Lord, now you are letting
your servant depart in 
peace, according to your 
word; for my eyes have 
seen your salvation that 
you have prepared in the 
presence of all peoples,”

Luke 2:29-31

The Word Thursday

January 4, 2018
Hooker, Oklahoma

 Texas County continues un-
der a burn ban extended by the 
three Texas County Commis-

abide by the restrictions in the 
burn ban to help protect Pan-

 The ban prohibits all persons 

 The ban allows no excep-

 Details on burn ban restric-
tions may be obtained from 

 The commissioners may 
choose to extend the burn ban if 

-

Assessment

 The Texas County Asses-

community assessment clinics 

be at Texhoma Anchor D Bank 

 The assessor will be avail-

-
-

 All property owners are re-
quired to be assesed by March 

-

property and family farm live-
stock taxation has been abol-

commercial livestock and mo-

 Anyone with questions or 
concerns may contact the asses-

 
loved ones passed away and 
obituaries were included in the 

more remembrance of those 
dear lives mourned in 2017 is 

Janice Carroll McBee

Bladimir Mesta

Billy Bob Mikles

Gilkey
Irene Fae Brown

Myra Gale Jarvis
Zackary Don McBee
Bobby Dean Jacobs

Billy Joe Brewer

Donley Gene Towner
Johnita Joy Gloden

Jana Jill Morris

Claude Edward Burns
Evelyn Friesen

June Elaine Burks Mathes

Headrick

Chad Hefner Colvin

Dwayne Mitchell

Calvin Keith

Betty Jean Herbel
Pauline Cherry Mills

Hellos
 Birth announcements in the 

in 2017 welcomed these special 

Macy Grace Davis

Oaklyn Joann Huxman
Aceyn Kade Jacobs
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Josh Allen
Staff Writer/Sports Editor

Konawa High School will 
host its annual Konawa Invi-
tational basketball tourna-
ment starting today through 
Saturday.

The girls will look to con-
tinue their winning and will 
face Langston Hughes today 
at 4:20 p.m. Should they win, 
the Lady Tigers will advance 
to the 4:20 p.m. Friday game 
to face the winner of Holden-
ville versus Lexington, which 
play this evening at 7:00. 

The other Thursday games 
include Douglas versus Des-
tiny Christian today at 11 a.m. 
The winner of that game will 
advance to the Friday round, 
facing the winner between 
Shawnee Junior Varsity and 
Glenpool. 

Winners of the Friday 
games will advance to the 
finals, which will be held 
Saturday at 6 p.m. Losers will 
have a chance at the Consola-
tion prize at 12:40 Saturday. 

Sharon Lerner

The Environmental Pro-
tection Agency has tasked a 
banker who was banned from 
the banking industry for life 
with oversight of the nation’s 
Superfund program.

In May, the Federal Deposit 
Insurance Corporation fined 
Oklahoma banker Albert 
Kelly $125,000. According 
to a consent order, which The 
Intercept obtained through 
the Freedom of Information 
Act, the FDIC had “reason to 
believe that [Kelly] violated a 
law or regulation, by entering 
into an agreement pertaining 
to a loan by the Bank without 
FDIC approval.”

Two weeks later, EPA 
Administrator Scott Pruitt 
appointed Kelly to lead 
an effort to streamline the 
Superfund program. In July, 
the FDIC went further, ban-
ning Kelly from banking for 
life. The “order of prohibition 
from further participation” 
explained that the FDIC had 
determined Kelly’s “unfitness 
to serve as a director, officer, 

person participating in the 
conduct of the affairs or as an 
institution-affiliated party of 
the Bank, any other insured 
depository institution.”

But Pruitt, who had 
received loans from Kelly’s 
bank, apparently didn’t find 
Kelly’s unfitness to serve in 
the financial industry as dis-
qualifying his longtime friend 
from serving as a top official 
at the EPA. Since May, Kelly, 
or Kell as he was known in 
Oklahoma, has led the effort 
to streamline the Superfund 
program — which oversees 
remediation of some of the 
country’s most toxic sites.

Pruitt earned only 
$38,400 as an Oklahoma 
state senator. Even with a 
$35,000 profit from selling 
his previous home, that was 
not enough on its own to 
buy a house in the Lakes at 
Indian Springs community in 
Broken Arrow, the suburb of 
Tulsa that Pruitt represented 
in the legislature.

Yet in 2004, Pruitt pur-
chased a sprawling ranch 
house in the upscale gated 

community for $605,000. 
Located on a half-acre corner 
lot in the Lakes, his stately 
Tudor looked out on a man-
made lake and had a stone 
fireplace, parking for five 
cars, and a storm-safe room.

To help pay for it, Pruitt 
turned to SpiritBank — a 
community bank that Kelly’s 
family had run since the 
1930s. SpiritBank gave Pruitt 
and his wife three mortgage 
loans: one for $81,000, 
another for $359,000, and a 
third for $533,000. His wife, 
Marlyn Pruitt, has reported 
no assets or income.

The year before, Spir-
itBank had also loaned 
Pruitt money to help buy a 
share of the Oklahoma City 
RedHawks, a minor league 
baseball team. That deal was 
made in partnership with a 
local businessman named 
Robert Funk, co-founder of 
an employment company.

On May 22, Pruitt returned 
the favor to the Oklahoma 
banker with his announce-
ment that he would be creat-
ing the Superfund task force 

— and appointing Kelly to 
head it.

The appointment was 
notable in that Kelly would 
become a senior adviser in 
the federal environmental 
agency despite having no 
previous experience with 
environmental issues. A busi-
ness major with a law degree 
and a 200-head cattle ranch, 
Kelly listed motivational 

Josh Allen
Staff Writer/Sports Editor

According to an Ameri-
can survey done by the 
Pew Research Center, there 
is continued growth in the 
share of the population that 
has no religious affiliation, 
commonly known as religious 
“nones”. 

Another survey done by 
the Pew Research Center, 
a nonpartisan organization 
that interviewed over 35,000 
Americans in 2007 and again 
in 2014, showed significant 
decline in those that identify 
with some type of Christianity 
(down from 78.4% in 2007 
to 70.6% in 2014). 

Despite that 7.8% decline, 
Christians are still the major-
ity, as America remains the 
most Christian country in the 
world. 

Conversely, the same 
two surveys from 2007 and 
2014, showed the largest 
increase was those that iden-
tify with no religion or athe-
ists, agnostics or religious 

“nones”, up from 16.1% in 
2007 to 22.8% in 2014.

The increase reflects the 
population of atheists grew 
from 1.6% to 3.1%, agnos-
tics went up from 2.4% to 
4.0% and “nothing in par-
ticular” grew from 12.1% to 
15.8%.

This changing U.S. reli-
gious landscape is also 
shown in Oklahoma, though 
Christians still make up 
almost 80% of the popula-
tion in the state. The religious 
“nones” have grown to only 
18% statewide, compared to 
22.8% nationwide.

So, in Oklahoma, almost 
half the population (47%) 
identify as Evangelical Chris-
tian and 18% identify as 
Mainline Protestant.

This shows, both in Okla-
homa and nationwide, the 
largest increase in Christian-
ity is those that identify as 
Evangelical Christian and 
fundamentalists.

However, there has also 
been a significant change in 
Americans’ views on moral-

ity and values, which is 
undoubtedly a result of the 
growth in the “nones”.    

“Most U.S. adults now say 
it is not necessary to believe 
in God to be moral and 
have good values (56%), up 
from about half (49%) who 
expressed this view in 2011,” 
the most recent survey said, 
which was released in 2017 
and concerned belief in the 

religious aspects of Christ-
mas. 

The 2017 survey found 
a growing number of Ameri-
cans say the religious aspects 
of Christmas are declining in 
public life, albeit somewhat 
slowly. 

There seems to be a 
shrinking share of the popu-
lation that believe the biblical 
account of the birth of Jesus 

depicts actual events, though 
those that do are still the 
majority. 

“For instance, there has 
been a noticeable decline in 
the percentage of U.S. adults 
who say they believe that bib-
lical elements of the Christ-
mas story – that Jesus was 
born to a virgin, for example 
– reflect historical events 

Attorney General Mike 
Hunter has filed five motions 
with the Oklahoma Corpo-
ration Commission (OCC), 
asking for an immediate 
reduction in customer rates 
from the state’s leading utility 
companies.

The attorney general’s 
request came the day that a 
sweeping overhaul of federal 
income taxes was signed 
into law, to take effect Jan. 
1. The new law lowers the 
highest corporate income tax 
rate from 35 percent to 21 
percent.

The estimated annual sav-
ings for Oklahoma Gas & Elec-
tric, Public Service Company 
of Oklahoma, Oklahoma Nat-
ural Gas, CenterPoint Energy 
and Arkansas Oklahoma Gas 
is approximately $100 mil-
lion, not including additional 
savings from other affected 
utility accounts.

Attorney General Hunter 
said he is requesting cus-
tomer rates be reduced by 
an amount reflecting lower 
federal corporate income tax 
rates.

“These companies will 
begin seeing major savings 
after the tax cut is imple-
mented on Monday,” Attorney 
General Hunter said. “Okla-
homans who are customers 
of these companies should 
immediately retain the ben-
efits of the savings from the 
tax cut in the form of lower 
rates. We urge the OCC to 
act quickly and in the best 
interests of customers, not 
company shareholders.”

Also in the motions, the 
attorney general is requesting 
the OCC protect customers’ 
ability to receive excess accu-
mulated deferred income tax, 
which is used to reflect utility 
companies’ past use of tax 
breaks to defer tax bills. With 
lower tax rates enacted, a por-
tion of accumulated deferred 
income tax would be unneces-
sary to cover future taxes--cre-
ating an “excess” portion.

Without OCC action, util-
ity companies could retain 
the entire benefit of excess 
accumulated deferred income 
tax, so the attorney general is 
requesting that the OCC create 
a temporary protection.

The actual treatment of 

Ken Childers

Managing Editor
 
If you would like to serve 

on the Seminole County Fair 
Board, you have an opportu-
nity to do so this year.

The filing period for candi-
dates opens Monday, Jan. 8 
and closes Friday, Jan. 12, 

2018.  
Those wishing to file may 

obtain the prescribed form 
from the County Clerk’s 
Office at the Seminole County 
Courthouse, 110 S. Wewoka 
Avenue, Wewoka, M-F 8:
00am-4:00pm.

2018 Seats up for re-elec-
tion:

Brian Carter – District #1
Robin Lambert – District 

#2
Clifton Taylor – District #3
Only registered voters of 

Seminole County are eligible 
to file as a candidate.

Any person so filing must 
reside in the Commissioner’s 
District they seek to repre-

sent. (Konawa is in District 
#1).

Prospective candidates 
must file with the County Clerk 
on the form prescribed by the 
Board of County Commission-
ers of Seminole County.

Current board members 
include Larry Bailey, Chad 
Huckleberry, Valerie Hogue, 

Janice Williamson, Ed Jones, 
Bobby Shackelford, Kathi 
Rodgers; Secretary, and 
Jerry Taylor, Maintenance.

The Seminole County 
Fair Board meets on the 
second Tuesday of each 
month at 6:30 PM at the
OSU Extension Office, 12827 
NS 3650, Wewoka, unless 

otherwise noted.
The Seminole County 

Fair will celebrate its 100th 
anniversary in 2021. Several 
special events and fundrais-
ers are in the works to help 
accessorize the new fair-
grounds. Visit www.seminol
ecountyfairok.com for more 
information.

Throwback 

Thursday
—Archive Photo

If you can remember 

shopping at Piggly Wiggly 

in downtown Konawa, you 

were around when this pic-

ture was taken in 1960. 

About a year after this photo 

was captured, a tornado hit 

the downtown area, causing 

extensive damage and injur-

ing five people. The twister 

hit on Feb. 17, 1961. At 

that time the population was 

1,555.

Seats Open on County Fair Board, Filing Period Begins Jan. 8

Survey Shows Religious ‘Nones’ Growing in Population Motions Filed 

Seeking Utility 

Rate Reduction

Konawa 

Invitational 
Starts Today

Banned From The Banking Industry For Life, 

Scott Pruitt Friend Finds New Home at EPA

Pruitt

(continued on page 8)
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This, That
& The Other

By

Hodge
Podge

Merry Christmas Mooreland…looking north on Main Street. Drone photo provided by Billy Bojorquez.

As a special Christmas activity, Mooreland sixth 
grade language arts students of Stacy Purviance were 
asked to write a poem about Christmas and they are 
being published along with class pictures…

A Random Christmas
By Jaysun Moline

We woke up with presents on 

Then we hear knocking on 
the door.

Then there was an explosion 
outside,

The reindeer busted though the 
wall because they smelled pie. 

Christmas
 By Alaina Crockett

It’s my favorite time of 
year,

It’s my favorite holiday.
We all scream out with 

cheer,
 And we say hooray! 

          

Christmas
My Favorite Holiday 

By Harry Benton
I set out cookies and milk 

out for the reindeer, 
Christmas is my favorite 

time of year,
I’ve already set up the tree 

to decorate,
It’s just one day to wait.

My Favorite Thing About 
Christmas

By Jose Ortega
I like Christmas night,
because we can see the 

lights so bright,
I love to cheer,
for the best New Year!

By Kase Donley
CHEER

We all cheer for a new  year,
Christmas is my favorite 

time of the year.
Then we hear the reindeer,
We get candy in our stock-

ing every year.

Christmas
Katelynn Purviance

We all cheer!
Christmas is here!
We like playing games,
And eating candy canes.
We go look for the elf,
he’s on the shelf.

Christmas
 By Ryder Tomberlin

Once there was a little boy,
that wanted a lot of things. 
The boy wanted toys, 
but they all would sing.

Christmas Cheer
By Hannah Eilers 

 I love putting up the lights,
On the long Christmas nights.
This is the year,
When everybody will cheer.

 I love to drink hot cocoa.

Christmas Cheer
By Rylee Wyrick

Christmas is time for joy and 
hope,

at Christmas time you shall 
never mope.

At this special time of year,
people love to hear holly jolly 

cheer.
You can go through town so 

merry and bright,
Santa will let you see his Christmas lights. You 

can sit on his lap,
you can also tell him a wish on your Christmas list.

 
CHRISTMAS DAY  

By Justyce Case 
Christmas is here,
This year was fun.
There is a lot of cheer. 
Now it’s done,
we had lots of fun.
                         

CHRISTMAS EVE
By Dwight Chase

Christmas Eve night Santa 
came,

I pulled out my baseball bat.
Then Santa went with a bang,
I  thought Santa was a robber 

that night.
Then I told Santa I was sorry,
He still gave me presents that 

night

Christmas is the
Best Holiday

By Olivia Kornele
I love all of the holiday cheer,
Christmas is the best time of 

year.
Jingle bells are ringing,
Carolers are singing.
I love all the light,
Every house is bright.
Soon it will be Christmas Day,
Santa will ride his sleigh,
Christmas is the best holiday!

Christmas Joy
By Nevaeh Sanchez

 On a cold winter night the 
South Pole is lit,

Pepper mints in hot cocoa.
This year was fun,
But now it’s done.
Let’s holler and cheer,
Because it a new year!

Christmas Lights
By Amy Cronister

Everywhere I go, I see Christ-
mas lights.

They shine beautifully on 
our tree.

You see them on cold Decem-
ber nights,

Hopefully there will be no 

for Santa will see!

Christmas Magic 
By Evelyn Sturgill 

Have you ever felt the magic,

head.
You set cookies out,
and go to bed.
With all the cheer,
this is Christmas every year.                                             

Here comes a Man                                                             
By Silas Mabra

You do not need a fan,
for here comes a man.
 With a bag full of toys and 

joys,  
 for all the little girls and boys.

CHRISTMAS
By Evan Sampson 

 Christmas my favorite hol-
iday,

 Many bright lights 
 Show at night 
And spread the holiday cheer!   

Christmas
By Aubrey Cummings
All the kids go to sleep,
Just waiting for one little 

peep.
They wait for morning to 

cheer,
When the parents hear the 

reindeer.

Christmas
By Autumn Van Zee 

Lets all cheer,
Christmas is here.
I like playing games and eating 

candy canes,
If I get coal,
I will be an unhappy soul.

Christmas 
By Caley Kahoe

Putting up all the lights,
Listening to all the cheer.
Waiting for a sound at night,
Everyone is getting a New 

Year.

Christmas
By Jayden Clark

It’s Christmas night,
And there’s a bunch of lights.
We always look for the elf,
Maybe it’s on the shelf.
We all like to chill, 
And have a big meal.
Then we all count down for 

the New Year,
And when it’s here, we all cheer!

Christmas Time…Sixth Graders’ Poems 

(continued on page 4)

• Woodward County Commis-
sioners voted Monday to place 
Woodward County under a two 
week burn ban. The ban will 
continue through Sunday, Jan. 7. 
Commissioners will look at the 
situation again during a regular 
meeting January 8 to see if the ban 
will be extended further. 

• Trash pick up in Mooreland 
will be one day later than normal 
the week of Christmas and New 
Year’s Day. Both holidays are on 
Monday this year, so trash will be 
removed Tuesday, Dec. 26, and 
Tuesday, Jan. 2.

• Thank you to all the business-
es who helped make this year’s 
Thanksgiving Turkey and Christ-
mas Ham Giveaways successful. 
All winners are very appreciative 
of our sponsors.

• Time is running out on shop-

By Fred L. Jones, Jr.
Eagle Staff Writer
fjones@theoklahomaeagle.net

On December 9, 2017,
Tulsan Rev. Glenna J. Huber
was formally installed as Rec-
tor (Senior Pastor) for The
Church of the Epiphany in
Washington, D.C. Huber is
the daughter of the late Dr.
Lawrence and Dr. Jayne Reed,
philanthropist and co-founder
of the Simon Estes Educa-
tional Foundation. Huber is
married to Richard Huber,
and they have two children –
Jonas (4), and Adayah (2).

Huber attended Holland
Hall High School in Tulsa and
received a Master of Divinity
degree from The General The-
ological Seminary (New York)
and her undergraduate de-
gree in history from Spelman

By Margaret Hicks
Eagle Staff Writer
mhicks@theoklahomaeagle.net

Candace (Jamison) Fields,
is the founder of The Cin-
derella Experience, now the
TCE Foundation, provides the
ultimate prom experience for
high school girls who are in
foster care. The experience in-
cludes the dress, the shoes &
accessories, the makeup, and
professional hair. 

          

Fields was born and
raised in Tulsa. She comes
from a family of pastors and
ministers and has a heart for
serving people. However, she
said she knows she is not
called to be a pulpit minister
and wondered what she could
do serve people and combine
that with her love for fashion. 

Fields said she grew up a
tomboy. She was a basketball
player. She said she wore ten-
nis shoes to her prom.

When she went away to
school at the Texas Women’s
University of Fashion and
Merchandising, she came
across a group of girls that
need the things that a young
woman needs to go to go to a
prom. Thus, The Cinderella

Experience was born. Fields
said that she believes “every
girl has two opportunities to
show herself to the world; on
her prom day and her wed-
ding day.” 
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“WE MAKE AMERICA BETTER WHEN WE AID OUR PEOPLE.” — E.L. GOODWIN SR. (1902-1978), PUBLISHER, 1936-1978

See TULSA REV., P.3 See CINDERELLA, P.3
REVEREND Glenna Huber (Photo courtesy of Jason Hoffman
Episcopal Diocese of Maryland)

The Cinderella Experience
Restoring Confidence

By Margaret Hicks
Eagle Staff Writer
mhicks@theoklahomaeagle.net

Residents at Cherokee Mead-
ows have been riddled with prob-
lems since the first residents moved
in Christmas Eve of 2016. They had
no mail delivery, no infrastructure
for telephones to be installed, mal-
functioning thermostats, and
plumbing problems which resulted
in some apartments being flooded.
There have been reported fires.
There is the on-going issue of the
curbs, that are have no lips, making
it difficult for cars and people to
gain safe entry to their rental prop-
erty.

Residents in wheelchairs and
those who use walkers and canes
have fallen. It was reported to The
Oklahoma Eagle that at least 25 peo-
ple have fallen. At least one of the
people who fell was not a resident.  

Over the past few months there
have been five reported “explo-
sions” and two of them 

happened in the same apart-
ment, with the most recent just a
few days ago. State Representative
Regina Goodwin (D), District 73,
stated, “On-going dangerous ex-
ploding walls and hazardous drive-
way curbs are life safety issues for
our seniors at Cherokee Meadows.
Senior citizens deserve safe access
and quality housing.”

Goodwin further stated: “For
almost a year now, there have
been questions about dangerous,
faulty infrastructure and cheap
development. Owner, Terry Carty
and Carland Properties received
approximately $1.2 million in fed-
eral/local dollars, including ap-
proximately $625,000 in tax
credits. Carland Properties contin-
ues to get paid monthly rent
money from senior citizens. Ear-
lier in the year, Goodwin and ten-
ants filed a complaint and federal
Housing and Urban Development
(HUD) officials came to Tulsa and

RESIDENT’S BEDROOM with insulation padding strewn about the room from the explosion, and the wall which was
cut way to expose the damaged area; this shows the insulation and rubber HVAC hose. (Contributed photos) See THINGS GO BOOM, P.3

Cherokee Meadows, Things Go Boom In The Night

CANDACE FIELDS with three of her “Cinderellas.” (Photo
contributed by Candace Fields)

Tulsan Rev. Glenna J. Huber Installed
As Rector For The Church Of The
Epiphany In Washington, D.C.

800.223.1600
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CANTON TIMES 
OFFICE HOURS
The Canton Times of-

-
tor, Lia Hillman, is lo-

-

-

CANTON TIMES
The

January 1
HAPPY NEW 

YEAR

January 4
2nd Semester 

begins

January 4-6 
Medford 

Tournament

January 8
Canton 

School Board 
Meeting

January 9
H.S.

Basketball @ 
Mooreland

January 11
Canton

Town Board 
Meeting

January 16
Home H.S. 
Basketball 

Game

Cities receive $159 Million
County returns total $28.8Million

The December distribution of sales tax collections by the 
Oklahoma Tax Commission primarily represents local tax 
receipts from October business.  Companies that remit more 

and pay electronically.  The monies they reported this period 
represent sales from October 16th to October 31st  and esti-
mated sales from November 1st to November 15th.

The disbursement of $144,305,720 in sales tax collec-

$11,995,117 from the $132,310,603 distributed to the cities 
and towns in December last year.  The use tax disbursement 
to cities and towns was $14,643,604.

In county returns, the counties shared in a $25,966,724 
sales tax disbursement and a $2,819,749 use tax disburse-
ment.Returns to Blaine County Towns compared to a year 
ago were: 
     Dec. 2017               Dec. 2016
Canton     $53,384.18             $14,987.28 
Geary (Blaine)  $59,131.70             $18,342.50
Geary (Canadian) $25,084.11             $34,166.65

Hitchcock   $3,423.35                    $856.08
Hydro (Blaine)  $3,820.43                 $5,880.78
Hydro (Caddo)  $14,802.09             $13,159.13
Longdale   $10,842.55               $3,955.22
Okeene     $61,876.52             $38,794.91
Watonga   $248,458.04         $262.456.33

Returns to Dewey County Towns compared to a year ago 
were: 
     Dec. 2017               Dec. 2016
Camargo   $4,369.93                 $2,623.84
Leedey     $11,169.07             $10,561.39
Seiling (Dewey)  $77,237.14             $46,780.40
Seiling (Major)  $19,313.44             $18,921.25
Taloga      $3,998.70               $15,253.84
Vici      $28,499.79             $28,935.02

By Max Nichols
Throughout the history 

of Oklahoma, the roles 
that women have played 
have evolved. From few 
pioneering women in 
business, politics and other 
aspects of public life to 
the civic leaders of today, 
women have left their mark 
on the state. The Oklahoma 
Historical Society celebrates 
the legacy of these women at 
its museum and sites.

“2018 marks the 
centennial of women’s 
suffrage in Oklahoma,” said 
Dr. Bob Blackburn, executive 
director of the Oklahoma 
Historical Society. “On Aug. 
5, 2018, an amendment to the 
Oklahoma Constitution that 
granted women in the state 

by a vote of the people.
“Oklahoma was the 

21st state to grant universal 
suffrage to women, more 
than two years before the 
19th Amendment to the 
United States Constitution 

they had the right to vote, 
women actively participated 
in Oklahoma public life ”

history of the plantation and 
the role of women within the 
Cherokee tribe, said Jennifer 
Frazee, historical interpreter 
at the site.

established the Watonga 
Republican newspaper, 
said Cindy Pitts, director 
of the T.B. Ferguson Home 
in Watonga, Okla. “T.B. 
Ferguson died on Valentine’s 

up as editor of the newspaper. 
That was unheard of at the 

sold the paper in 1930. She 
acted as technical advisor on 

novel. The novel was based 
on the early day experience 

The Pioneer Woman 
Museum in Ponca City, 
Okla., presents a major 
exhibit about the role 
Oklahoma women have 
played in journalism and 
broadcasting, said Director 
Kelly Houston. Another 
special exhibit provides an 
“exciting history of women 
in Wild West Shows.” The

of the newspaper. They sold 
the newspaper and moved 
to Oklahoma City, where 
she became a columnist 
for the Oklahoma News. 
Her column, A Woman’s 
Viewpoint, appeared in other 
U.S. newspapers. 

At the Oklahoma History 
Center in Oklahoma City, 
the “African American 

the remarkable civil rights 

Clara was a teacher and 
became an advisor to the 
Oklahoma City chapter of 
the National Association for 
the Advancement of Colored 
People (NAACP) Youth 
Council in 1957. She staged a 
sit-in at Oklahoma City’s Katz 
Drug Store on Aug. 20, 1958, 
walking into the store and 
ordering Cokes at the “whites 
only” lunch counter. Under 
her leadership, the Youth 
Council participated in sit-
ins through the early 1960s, 
helping to end segregation 
in public accommodations in 
Oklahoma.

From 1960 to 1980 

and later she chronicled her

One for the Oklahoma History Book

December 22, the Canton High School bas-

Canton competes 
on Thunder court

Although there wasn’t a white Christmas, the weekend brought 
single-digit temperatures and a frozen Canton Lake (photo by 
George Eischen).

CANTON LAKE FREEZES OVER

Debbie Jackson, Tulsa World Sun-
day editor, is retiring after 46 years in 
the newspaper business. 

Jackson first worked at the Hen-
ryetta Daily Free-Lance for J. Leland 
Gourley, an Oklahoma journalism 
legend. When Gourley put the Free-
Lance up for sale in 1973, Jackson 
was offered a job at the Daily Oklaho-
man, but Gourley encouraged her to 
apply at the Oklahoma Journal.

The Journal offered her $25 a 
week more than The Oklahoman and 
the deal was sealed. 

At the Journal, Jackson honed her 
skills in editing and page design. It’s 
been a major part of her career ever 
since.

Susan Ellerbach, the World’s exec-
utive editor, said “Jackson is the type 
of journalist we all aspire to be.”

“Her standards have always been 
high,” Ellerbach said. “We’ve worked 
together for 30 years, and this news-

room won’t be the same without her 
knowledge and support.”

Jackson joined the staff  at the 
Tulsa World in 1979 as a copy editor 
and soon became an assistant city 
editor. In 1985, she was named as the 
first woman to serve as the World’s 
city editor, a job she loved.

“It’s the best job in the newspa-
per,” she said. “Every day you walk 
in the door it’s a clean sheet. You 
don’t know what’s going to happen.”

She left that position after 10 years 
to become Sunday editor, overseeing 
the World’s Sunday edition as well as 
several special projects. 

In 2014, she began a popular week-
ly feature called “Throwback Tulsa,” 
revisiting often forgotten aspects of 
Tulsa’s past.

Jackson was inducted into the 
Oklahoma Journalism Hall of Fame 
in 2009.

First female city editor 
at Tulsa World retires 

Tulsa World Sunday Editor Debbie Jackson, at her desk in the World newsroom.
Photo by Jessie Wardarski/Tulsa World. Reprinted with permission.
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LEGAL ADVICE
is just one of the benefits of being a member of the Oklahoma Press 
Association’s Legal Services Plan. Remove the worry of needing 
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S 

LEGAL SERVICES PLAN 

1-888-815-2672 or 405-499-0020

Another newspaper has fallen victim 
to the ransomware virus.

One of the worst case scenarios I 
can imagine is waking up on a Monday 
morning, going to the office and 
discovering your equipment has been 
infected by a virus.

All your files are locked up on several 
computers in the office, as well as all the 
files on the server. 

 As you dig around the office for some 
old files on a flash or backup drive, you 
start worrying about how you will get 
the paper out this week and where you 
will find copies of your current ads.

Then comes the anger. You thought 
you were safe but realize that isn’t the 
case. It’s a hard pill to swallow.

And it all started with ransomware 
named Paradise.

That’s an ugly Monday morning, 
folks. So before it happens to you, let’s 
look over this checklist to see if you’re 
really safe.

• Do all computers in the office have 
full antivirus that includes ransomware 
protection? 

• Do all off-site computers have the 
same protection? 

• Are your firewalls on? Look at 
each computer and see if the firewall is 
active. I know this can be a hassle, but 
it prevents unauthorized applications, 
programs and services from getting 
incoming connections on the computer. 

• Does your antivirus have plug-ins 
for all the browsers on the computer? 
These plug-ins stop hackers from 
hopping directly onto your computer 
from a misguided click on some link. 

• Consider a hardware firewall that 
filters requests before they are allowed 
in your network. These can be set up 
by your internet provider, who may also 
provide the box. This could be a good 
solution if several people are logging in 
remotely. The cost starts at around $300. 

• VPN routers also are available. 
They create a virtual private network 
for your office, and are easier to set up 

and emulate hardware firewalls in many 
ways. Cisco makes one starting at $160. 

• If the router you have is a newer 
one, just log into it and make sure the 
firmware is up-to-date. The firmware 
updates rules for what comes and goes 
through the router.

• To ensure the firewall is working on 
a Mac computer, go to System Preferences 
> Security, then look for the firewall 
button. In order to activate it, click the 
lock on the bottom left corner of the box 
and put in the computer’s password. 

• On Windows computers look in 
Control Panel > Windows Firewall. In some 
cases it will say that the settings are 
being managed by another vendor’s 
application. That means that the antivirus 
running on the computer has taken over 
the job of putting up a firewall. Look at 
the antivirus setting to see the firewall 
there. 

As an employee, these setting are 
your best defense against losing your 
computer’s files.

• Turn on Show File Extensions on 
both Macs and PCs. From the desktop 
on a Mac, go to Finder > Preferences 
> Advanced. Check Show All File Name 
Extensions. This makes it easier to spot 
suspicious files. If it says something 
like (.PDF.EXE) you will see the (.exe) 
extension  and know not to click on it. 

For Windows XP and 7, open Windows 
Explorer. You can do this by clicking My 
Computer from the Start Menu. Click the 
Tools menu on the menu bar in Explorer, 
then click the Folder Options item in the 
popup menu that appears. When the 
dialogue A dialog box appears, click the 
View tab at the top of the window.

• Look for Hide file extensions for 
known file types and uncheck the box to 
disable it. Click Apply to all folders, then 
click Apply and then OK.

Windows 10 is a little different. 
Instead of “My computer” it’s called  
“This PC”.  Go to View menu and check 

File names and Extensions. Now all the 
extensions will show on the desktop and 
everywhere else. 

Your best defense is a good backup 
system. If there is a server in the 
building back it up with not one but two 
external hard drives – one always off 
site. Switch them back and forth each 
week. Use the server’s software to do 
the backup. 

For backup, use drives that have 
their own power supply with USB3 or 
Thunderbolt connections. The larger 
drives seem to last longer. One that I 
recommend is the G-Technology G-Drive 
USB 3.0 2TB External Hard Drive. It’s 
available on Amazon for $139.95.

Use a file service like Google Drive 
or One Drive to back up your files. 
However, even these can be hit by 
ransomware if the computer is logged 
into the drive while the attack on the 
computer is happening. The two drive 
backup system seems to be the safest. 
At least you’ve only lost a week’s worth 
of work if things go south.

If the paper is under attack and you 
notice it, unplug the network until the 
virus is cleaned from the computers. 
Reformatting the drives is best but not 
always possible due to software issues.

At the very least, back up some of 
the more important files for future 
recovery. Clearly label the drive so it 
doesn’t get plugged in and used by some 
unsuspecting employee, requiring you 
to start the whole process over.

Many times, you will be asked to pay 
a fee to recover your files. I don’t believe 
in paying these people one red dime. 
They are the worst kind of attackers. 
Report it as a crime to the FBI, which is 
always working on this type of problem.

Don’t think it can never happen to 
you. It’s happened to lots of people and 
the hackers get better every day. 

WHERE’S THAT IN GIMP?
Many papers are using Gimp software 

to correct photos for the newspaper. 
New employees who have been trained 
in Photoshop may have trouble finding 
settings in Gimp.

Let’s look at a simple comparison 
of menus in Photoshop and Gimp. For 
this comparison, we will be cutting out 
an object from one photo to place into 
another one. This is frequently done in 
advertising to add a person who was 
missing from the photo.

Start with the photo that has the 
person you want to cut out. We’ll leave 
color correction for later. It helps to have 
both photos open at the same time. I 
prefer working with a copy of the photo 
so if something messes up, I can go back 
to the original and start over.

Make sure both images you’re 
working on have the same resolution. 
This is found at Image > Image size in 
Photoshop and Image > Scale Image in 
Gimp.

 In Photoshop, get the section tool of 
your choice – Lasso or Polygonal Lasso. 
Make sure the tool is feathered 3 to 5 
pixels. Cut out the person remembering 
that some cleanup can be done in the 
other file when the object is on its own 
layer. 

In Gimp, use the Free Select tool. It 
looks like a lasso tool. Select the art then 
add the feather under Select > Feather. 

In either program, cut your selection 
and paste it in the other photo.

A free transform may be needed to 
get the pasted object to be a good match 
for what is in the photo with all the other 
people. In Photoshop, look under Edit > 
Free Transform. 

This tool gives you handles to reshape 
the image. In Gimp, you can scale the 

layer but not as good 
as in Photoshop. 
Look for the scaling 
tools in the main 
tool box. They have 
one called the Cage 
tool that does free 
transform but it’s a 
bit clunky.

Once the item is 
placed in the correct 
place, use the eraser 

tool to clean up the layer you brought in 
until it blends smoothly. In Photoshop, 
use a soft brush with fuzzy edges. 

In Gimp, make sure Tool options 
are visible. If not, look under Windows > 
Dockable Dialogs (the options bar window 
for Gimp). Choose a soft brush. 

Save a copy of the photo after you 
have added the person to make sure 
everyone likes the placement of the 
person.

Now flatten the photo and color 
correct it. 

Photoshop: Layer > Flatten Image
Gimp: To do the same steps in Gimp, 

go to Image > Flatten Image.
Photoshop: Do your normal color 

correction using Curves/Levels, 
Unsharp mask  and Image size.

Gimp: Levels is under Colors menu > 
levels. Image size is under Image > Scale 
Image. Unsharp Mask is under Filters > 
Enhance > Unsharp Mask. Gray scale is 
under Image > Mode  > Gray Scale. 

The final PDF setup will have to 
convert the photo to CMYK in your 
layout program if the paper uses Gimp 
for a photo correction program. 

If Gimp is all that the paper has in 
house, keep digging for those features. 

Protect your computers from ransomware attacks
Computer Notes

from the road
by Wilma (Melot) Newby
wnewby@okpress.com

OPA Computer Consultant Wilma Newby’s column is brought to you by the Oklahoma Advertising Network 
(OAN). For more information on the OAN program, contact Oklahoma Press Service at (405) 499-0020.
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“DESIGN IS NOT just what it 
looks like and feels like. Design is 
how it works.”         — Steve Jobs.

That’s it. In one brief sentence.
Of course, readers want a newspaper 

that looks right…and feels right. They 
want the look and feel of their paper to 
reflect their community.

But what they want most of all is for 
their newspaper to work right for them.

Ask readers, and they will tell you 
they want:

• TEXT THAT is legible, with size and 
spacing that keeps makes it comfort-
able to read.

• DESIGN ELEMENTS like standing 
heads, section flags and columns sigs, 
that are simple and clean.

• CONSISTENCY of these design ele-
ments throughout the entire newspa-
per.

• DISPLAY FONTS that are readable, 
crisp and appealing.

• SHORTER STORIES that are written 
clearly and flow easily.

• EDITING that makes these stories 
even easier to follow.

• PHOTOS THAT grab reader attention 
because they have interest, informa-
tion and impact.

• PAGE STRUCTURE that makes it 
easier for readers to see what goes 
with what.

• SPACING between packages that 
helps readers see that structure.

• COLOR USE that makes sense.

• TINT BLOCKS that add impact—but 
don’t make type difficult to read.

• SEQUENCING that makes the dif-
ferent content areas of your news-
paper (e.g., news, opinion, sports, 
features…) easy to follow.

• CONSISTENT placement of that con-
tent from issue to issue.

We can give readers all of these. And, 
in the process of doing that, we can rid 

our newspapers of those elements that 
create clutter and confusion.

If we start with how design works, it 
just makes sense that we’ll create a bet-
ter design.

ED HENNINGER, an independent newspaper con-
sultant and director of Henninger Consulting, offers 
comprehensive newspaper design services including 
redesigns, workshops, design training and design 
evaluations. Contact Henninger at www.henninger-
consulting.com, email edh@henningerconsulting.
com or phone (803) 327-3322.

Create better design by knowing how it works

The infobox at left has more impact, but it’s so dark the text will be very difficult to 
read. Better to use a much lighter screen…or a shadow box.

It’s time to enter the 
OPA BETTER 

NEWSPAPER CONTEST!
ENTRY DEADLINE:

MONDAY, FEB. 8, 2018

See Contest Rules and Info at 
www.okpress.com/contest

You’ve Got Questions!
• Can I photograph minors without consent?

• Can police deny access to records
by issuing a press release?

• Should I alter my archives
when a person demands it?

• Can I report inaccurate 
tesimony given in open court?

• What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA 
Legal Services Plan members in recent months. Newspapers always 
need timely legal advice on issues related to newspaper publishing.

You should join OPA’S
LEGAL SERVICES PLAN!

See www.OkPress.com/LSP or contact Lisa Sutliff 
at (405) 499-0026 or toll-free in Oklahoma 1-888-815-2672 



12     The Oklahoma Publisher // January 2018

Thank you for continued 
support of “Share The Warmth”
Read the Winning Columns & Editorials on the OPA website: 

www.OkPress.com (Under Contests)

Enter and Win 
a $100 Check 

from Oklahoma 
Natural Gas!

The November 2017 Oklahoma Natural 
Gas Column and Editorial Contest was 
judged by a member of the Oklahoma 

Journalism Hall of Fame.

1. Each month, send a tear sheet or 
photocopy of your best column and/
or editorial to Oklahoma Natural Gas 
Contest, c/o OPA, 3601 N. Lincoln 
Blvd., Oklahoma City, OK 73105-5499. 
Entries also may be emailed (full-page 
tearsheet) to jgilliland@okpress.com.

2. Include the author’s name, name of 
publication, date of publication and 
category entered (column or editorial).

3. Only ONE editorial and/or ONE column 
per writer per month will be accepted.

4. All entries for the previous month must 
be at the OPA office by the 15th of the 
current month.

5. Winning entries will be reproduced on 
the OPA website at www.OkPress.com.

Entries must have been previously 
published in print. Contest open to 

all OPA member newspapers.

Although Oklahoma Natural Gas Company 
selects representative contest winners’ 
work for use in this monthly ad, the views 
expressed in winning columns and editorials 
are those of the writers and don’t necessarily 
reflect the Company’s opinions.

OKLAHOMA NATURAL GAS CONTEST WINNERS

Last month I wrote a series about domestic violence. I wrote 
my own experience with this national problem. While writing 
the series I discovered how much the perspective has 
changed regarding this, but I also discovered how much it 
has remained the same.
Changes have been made to laws as well as the training of 
law enforcement on how to handle these situations. When 
I went through my experience, there was no such thing as 
stalking.
There are now laws to protect victims from their stalkers.
Law enforcement officers now receive training as well as 
the use of forms to determine the severity of the abuse. 
According to Deputy Scott Hawkins, there are questions on 
the forms that can “trigger” the need for safety plans without 
the victim asking directly for help.
The public as a whole is more aware and informed about 
domestic violence. However, the age-old question of “Why 
didn’t she just leave?” still tends to be the first question 
asked. I said it in the series and I’ll say it again here. It is not 
that simple. The abuse begins slowly and by the time you 
consider leaving, the abuser has control over your life. When 
they feel that control is slipping is when things become more 
violent. When you gather the courage to leave is when the 
abuser feels he or she has lost all control. This is when they 
become the most violent.
It is not always a threat directed at the victim that keeps 
them in the relationship. It is often a threat to those they love. 
I know my ex made threats to me to harm members of my 
family.
This was way more terrifying than the thought of staying 
in the relationship. I made the choice to marry this person. 
My family should not be harmed for my bad decisions. So I 
stayed in the relationship much longer than I should have.
Sometimes the threats are made against the pets. For most 
of us our pets are an extension of our family and most 
shelters are not equipped to take in the victim and their 
pet. However, I recently saw where the Women’s Resource 

Center of Norman opened a shelter for the dogs and cats of 
abused women.
So many changes are being made to make it easier for 
victims to leave their abusers. Pottawatomie County is 
looking at an opportunity to make leaving easier with a new 
Family Justice Center.
The Family Justice Center’s One Safe Place offers a way out 
to victims. “We have investigators, advocacy, prosecutors, 
legal aide and mental health services,” said Cathy Adams, 
Assistant District Attorney.
All of these services located in one place. No need for 
multiple stops. I can only imagine how awesome that would 
be. The ability to walk out of an abusive relationship and into 
a facility designed to wrap their services around you, to lift 
you up emotionally, psychologically and spiritually. A place 
where they believe you, believe your story.
“One of the big keys that is important to me personally,” said 
District Attorney Richard Smothermon, “research shows, 
that after the basic needs are met, that is food and shelter, 
clothing, maybe transportation, the third most important thing 
is spiritual care. Because you had this traumatic event, you 
need somebody to talk to.
“Right back here in my floor plan is a chapel. You walk in 
these doors, no access here, no access here, then over 
here these are all sealed entrances. You can talk to the 
receptionist, you can go to the bathroom or you can go pray.”
The Family Justice Center’s One Safe Place is well on its 
way to becoming the one stop shop it should be, but they 
will need the help of the community to bring this vision to 
fruition. A time will come when money will be needed to build 
a facility to host all of the services mentioned above as well 
as a courtroom, a chapel and possibly a school. This will be 
a place where the victim and their children can go and feel 
safe and protected.
This will be a place where their lives will be changed, saved. 
This will be One Safe Place.

NOVEMBER 2017 COLUMN WINNER
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A place where lives can be changed
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